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LIST OF EXPERIMENTS with CO Mapping-3161903(CAD) 

   

Sr.No Name of Practical 
CO 

MAPPING 

01 

Prepare a program for plotting lines and curves using algorithms learned. 

 Students will prepare the Program in C Language for the assignment given. 

(Bresenham‟s Line , DDA Line , One C-Graphics Object etc) 

CO1 

02 

Introductory exercise for 3-D modeling 

 Students will draw 2D-sketches first using the basic commands in the sketch 

module in 3D-Modeling software to get acquainted or use too. 

 Students will generate the 3D- Solid model using the commands learned in 

the lab session. 

CO2 

03 

Exercise for advanced 3-D modeling. 

 Students will generate / draw the advanced 3D model given in the 

assignment. 

CO2 

04 

Exercise for 3-D editing options 

 Students will learn and operate the editing features available in the 3D 

modeling software on the model created previously. 

CO2 

05 

Exercise for Assembly modeling. 

 Students will prepare the 3D Assembly given in the assignment in 3D 

Modeling software. 

CO2 

06 

Exercise for FEA of 1-D structural problems. 

 Students will perform analysis in licensed Ansys Software for simple 

problems given in assignment and verify the manual calculation. 

CO4 

07 

Exercise for FEA of trusses.  

 Students will perform analysis in licensed Ansys Software for simple 

problems given in assignment and verify the manual calculation. 

CO4 

08 

Exercise for FEA using Beam Element 

 Students will perform analysis in licensed Ansys Software for simple 

problems given in assignment and verify the same via manual calculation. 

CO4 

09 

Exercise for FEA of 1-D thermal problems. 

 Students will perform analysis in licensed Ansys Software for simple 

problems given in assignment and verify the manual calculation. 

CO4 

10 

Exercise for FEA of 2-D structural problems 

 Students will perform analysis in licensed Ansys Software for simple 

problems given in assignment and verify the manual calculation. 

CO4 

11 
Exercise for developing the optimization model of machine elements using Johnson 

Method. 
CO5 

 

Course Outcome: (As per GTU) 

3161903.1 Demonstrate basic concept of computer aided design and its applications. 

3161903.2 Make use of various concepts and characteristics in geometric modeling. 

3161903.3 Analyze geometric transformations 

3161903.4 Determine stress and strain in structural elements through FEA 

3161903.5 Summarized optimization techniques for design of machine elements. 
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Following Instructions are mandatory for Laboratory/Term Work 

1. Students are required to solve their tutorials/assignments as per instruction of the faculty and get them signed 

before due date. 

2. Students are required to bring a note book for rough work, pencil, eraser, sharpener, compass, foot rule, and 

calculator along with a reference book for the subject in the laboratory. 

3. Experiments and tutorials/assignments/quiz will be regularly assessed and the cumulative marks will form 

your final score of term work at the end of semester. 

4. Students should prepare their journals in best possible way. Your journal should be simple yet attractive. 

Getting your journal checked regularly by concerned faculty is an indication of regularity of work. 

5. Students must attend each and every practical that will help you in answering your oral exams. Ask the 

questions to your faculty whenever you find difficulty in understanding the Practical‟s. 

6. Every student should maintain the laboratory manual properly. 

7. Students must come to the laboratory in proper dress code. Half pants, loosely hanging garments and slippers 

are not allowed.  

8. Students must ensure that their work areas are clean and dry to avoid any accident.  

9. In CAD Lab, all students must enter the details in the entry register available on lab entrance. 

10. Keep your bags in the stand or rack provided. 

11. Properly operate the PC as per the instruction of lab assistant/faculty. For storage of files/work use only Drive 

of Computer. 

12. Do not misuse the internet (i.e, do not upload/download any unlawful/unwanted material)  

 

In this laboratory you will be exposed to the modeling and analysis software. Laboratory experiments will 

consist of hands on session and demonstration of the above mentioned experiments.  

You are required to submit a report on each laboratory session in the following that session if asked. You have to 

refer to the textbooks / reference book for appropriate answers to the questions. 

 

 

 

 

  



Date:      /     /2024 

EXPERIMENT: 01 

Aim: Prepare a programme for plotting lines and curves using algorithms learned. 
 

Theory:  

Introduction 

 

Computer-aided design is essentially based on a versatile and powerful technique called 

computer graphics, which basically means the criterion and manipulation of pictures on a display 

device with the aid of a computer. Computer graphics originated at the Massachusetts institute of 

technology (MIT) in 1950 when the first computer-driven display, linked to a Whirlwind 1 

computer, and was used to generate some pictures. The first important step forward in computer 

graphics came in 1963 when a system called SKETCHPAD was demonstrated at the Lincoln 

Laboratory of MIT. This system consists of a cathode ray tube (CRT) driven by TX2 computer. The 

CRT had a keyboard and a light pen. Pictures could be drawn on the screen and then manipulated 

interactively by the user via the light pen.  

 

This demonstration clearly showed that the CRT could potentially be used as a designer‟s 

electronic drawing board with common graphic operations such as scaling, translation, rotation, 

animation and simulation automatically performed at the „push of a button‟. At that time, these 

systems were very expensive; therefore they were adopted only in such major industries as the 

aircraft and automotive industries where their use in design justified the high capital costs. Another 

crucial factor preventing computer graphics from being generally applied to engineering industries 

was that there was a lock of appropriate graphics and application software to run on these systems. 

However, a computer-based design system was clearly emerging. Since these pioneering 

developments in computer graphics, which had captured the imagination of the engineering industry 

all over the world, new and improved hardware, which is faster in processing speed, larger in 

memory, cheaper in cost and smaller in size, have become widely available. Sophisticated software 

techniques and packages have also been gradually developed. Consequently, the application of CAD 

in industry has been growing rapidly. Initially CAD systems primarily were automated righting 

stations in which computer controlled plotters produced engineering drawings. The system were 

later linked to graphic display terminals where geometric model describing part dimensions were 

created, and the resulting database in the computer was then used to produce drawings.  

Nowadays, CAD systems can do much more than mere righting. Some systems have analytical 

capabilities that allow parts to be evaluated with techniques such as the finite element method. There is also 



kinematics analysis Programs that enable the motion of mechanism to be studied. In addition, CAD system 

includes testing techniques to perform model analysis on structures, and to evaluate their response to pinpoint 

any possible defects.  

The term computer graphics includes almost everything on computers that is not text or sound. 

Today almost every computer can do some graphics, and people have even come to expect to control 

their computer through icons and pictures rather than just by typing. Here in our lab at the Program of 

Computer Graphics, we think of computer graphics as drawing pictures on computers, also called 

rendering. The pictures can be photographs, drawings, movies, or simulations - pictures of things, which 

do not yet exist and maybe could never exist. Or they may be pictures from places we cannot see 

directly, such as medical images from inside your body. We spend much of our time improving the way 

computer pictures can simulate real world scenes. We want images on computers to not just look more 

realistic, but also to be more realistic in their colors, the way objects and rooms are lighted, and the way 

different materials appear. We call this work “realistic image synthesis”. 

 

 

Fig 1.1: Conceptual Model of Interactive Graphics 

 

 

Thus the graphics system is a layer in between the application program and the display hardware that 

effects an output transformation from objects in the application model to a view of the model. The 

objective of the application model is to captures all the data, objects, and relationships among them 

that are relevant to the display and interaction part of the application program and to any non 

graphical post processing modules. 

 

 

 DDA Line Drawing Algorithm: 

Digital differential analyzer (DDA) is hardware or software used for linear interpolation of variables over an 

interval between start and end point. DDAs are used for rasterization of lines, triangles and polygons. DDA 

algorithm is an incremental scan conversion method. Here we perform calculations at each step using the 



results from the preceding step. The characteristic of the DDA algorithm is to take unit steps along one 

coordinate and compute the corresponding values along the other coordinate. 

 

Algorithm:   

1. Read the line end points (𝑥1,y1) and (𝑥2,𝑦2) such that they are not equal. [If equal then plot that point 

and exit] 

2. d𝑥 = |𝑥2 − 𝑥1|and d𝑦 = |𝑦2 –𝑦1| 

3.  If (d𝑥 ≥ d𝑦) 𝑡ℎ𝑒𝑛 

Length=d𝑥 

else  

Length=d𝑦 

end if 

4. 𝑥inc = (𝑥2 − 𝑥1)/𝑙𝑒𝑛𝑔𝑡ℎ 

              𝑦inc = (𝑦2 − 𝑦1)/𝑙𝑒𝑛𝑔𝑡ℎ 

            [This makes either d𝑥 or d𝑦 equal to 1 because length is either |𝑥2 − 𝑥1| or |𝑦2− 𝑦1|      Therefore, 

the incremental value for either x or y is one.] 

5. i=1 [begins the loop, in this points are plotted] 

While (i≤length) 

{ 

Plot (integer(x), integer(y)) 

𝑥 = 𝑥 + 𝑥inc 

𝑦 = 𝑦 + 𝑦inc 

𝑖 = 𝑖 + 1 

} 

 

 

Advantages of DDA Algorithm: 

 It is the simplest algorithm and it does not require special skills for implementation. 

 It is a faster method for calculating pixel positions than the direct use of equation.  

y = mx + b.  

 It eliminates the multiplication in the equation by making use of raster Characteristics, so that appropriate 

increments are applied in the x or y direction to Find the pixel positions along the line path. 

Disadvantages of DDA Algorithm: 

 Floating point arithmetic in DDA algorithm is still time-consuming. 

 The algorithm is orientation dependent. So the end point accuracy is poor. 

 

Bresenham's line algorithm: 

Bresenham's line algorithm is an algorithm that determines which points in an n-dimensional raster 

should be plotted in order to form a close approximation to a straight line between two given points. It is 



commonly used to draw lines on a computer screen, as it uses only integer addition, subtraction and bit 

shifting, all of which are very cheap operations in standard computer architectures. It is one of the earliest 

algorithms developed in the field of computer graphics. A minor extension to the original algorithm also deals 

with drawing circles. 

1. Read the line end points (𝑥1,y1) and (𝑥2,𝑦2) such that they are not equal. [If equal then plot that point 

and exit] 

2. plot start point 

3. calculate the constant dx,dy,2dx,2dy and get the first value for initial parameter 

               Pk=2dy-dx 

4. at each xk along the line starting at k=0 perform the following test pk<0,the next point to plot is    

                                    (xk +1,yk)  and  pk+1=pk+2dy 

          else (xk +1,yk+1) 

                                           pk+1=pk+2dy-2dx 

5. Repeat step 4 till (dx-1)times 

 

 

Output primitives  

 A picture can be described in several ways.  

In a raster display, a picture is completely specified by the set of intensities for the pixel positions in 

the display.  

At the other extreme, a picture can be described as a set of complex objects, such as trees and terrain 

or furniture and walls, positioned at specified coordinate locations within the scene. 

 Shapes and colors of the objects can be described internally with pixel arrays or with sets of basic 

geometric structures, such as straight line segments and polygon color areas. 

 The scene is then displayed either by loading the pixel arrays into the frame buffer or by scan 

converting the basic geometric-structure specifications into pixel patterns. 

 Graphics programming packages provide functions to describe a scene in terms of these basic 

geometric structures, referred to as output primitives, and to group sets of output primitives into more 

complex structures.  

 Each output primitive is specified with input coordinate data and other information about the way that 

object is to be displayed. 

 Points and straight line segments are the simplest geometric components of pictures. 

 Additional output primitives that can be used to construct a picture include circles and other conic 

sections, quadric surfaces, spline curves and surfaces, polygon color areas, and character strings. 

 

 



Point Plotting: 

 Point plotting is attained by converting a single coordinate position furnished by an application 

program into appropriate operations for output device in use.  

 For example, with a CRT monitor, the electron beam is turned on to illuminate the screen phosphor at 

the selected location. The electron beam is positioned based on the display technology.  

 For a random-scan(vector) system :  

 This stores point-plotting instructions in the display list.  

 Coordinate values in these instructions are converted to deflection voltages that position the 

electron beam at the screen locations to be plotted during each refresh cycle.  

 For a black-and-white raster system,  

 a point is plotted by setting the bit value corresponding to a specified screen position within 

the frame buffer to 1.  

 Then, as the electron beam sweeps across each horizontal scan line, it emits a burst of 

electrons (plots a point) whenever a value of 1 is encountered in the frame buffer.  

 With an RGB system raster system  

 The frame buffer is loaded with the color codes for the intensities that are to be displayed at 

the screen pixel positions.  

Line Drawing: 

o The line is the most fundamental drawing primitive with many uses - charts, engineering drawings, 

illustrations, 2D pencil-based animation and curve approximation. 

o Desired properties of line drawing algorithms : 

o Lines should appear sharp and straight 

o Line should terminate accurately 

o Line should have constant density 

o Line density should be independent of line, length and angle. 

o Efficient  

o Line drawing is accomplished by calculating intermediate positions along directed to fill in these 

positions between the endpoint positions. An output device is then directed to fill in these positions 

between the endpoints. 

o For analog devices, such as a vector pen plotter or a random-scan display, a straight line can be drawn 

smoothly from one endpoint to the other. Linearly varying horizontal and vertical deflection voltages 

are generated that are proportional to the required changes in the x and y directions to produce smooth 

lines. 

o Digital devices display a straight line segment by plotting discrete points between two endpoints. 

Discrete coordinate positions along the line path are calculated from the equation of the line.  

o For a raster video display, the line color (intensity) is then loaded into the frame buffer at the 

corresponding pixel coordinates. Reading from the frame buffer, the video controller then "plots" the 

screen pixels. Screen locations are referenced with integer values, so plotted positions may only 



approximate actual Line positions between two specified endpoints. A computed line position of 

(10.48, 20.51), for example, would be converted to pixel position (10,211. Thus rounding of 

coordinate values to integers causes lines to be displayed with a stair step appearance Figure 1.2 

 

Fig 1.2 Stair step effect (jaggies) produced when a line is generated as a series of pixel positions. 

 

o The characteristic stair step shape of raster lines is particularly noticeable on systems with low resolution; 

their appearance is improved by displaying them on high-resolution systems.  

o More effective techniques for smoothing raster lines are based on adjusting pixel intensities along the line 

paths. 

o For the raster-graphics device-level algorithms, object positions are specified directly in integer device 

coordinates. The pixel positions are referenced according to scan-line number and column number (pixel 

position across a scan line). This addressing scheme is shown in Figure 1.3.  

 

Fig 1.3 Pixe1 positions referenced by scan line number and column number. 

 

o Scan lines are numbered consecutively from 0, starting at the bottom of the screen; and pixel columns are 

numbered from 0, left to right across each scan line.  

o To load a specified color into the frame buffer at a position corresponding to column x along scan line y, 

a low-level procedure set Pixel of the form is used  

set Pixel(x,y) 

o To retrieve the current frame buffer intensity setting for a specified location the low-level 

     Function get Pixel is used get  

Pixel(x,y) 

 



Procedure:  

 

1. Students are informed to prepare the algorithm for line using the DDA and Bresenham‟s method. 

2. Students are informed to prepare the algorithm for drawing the circle using Bresenham‟s method. 

3. Prepare the C Program of above algorithm, run the program in computer. 

4. Plot the output result and take printout. 

5. Students also have to write the program in the files pages with the below mention assignment 

questions. 

 

Questions for Experiment-1: 

1. Prepare flow chart for DDA, Bresenham‟s algorithm for rasterizing a line and Write a C program 

for the same 

2. Prepare flow chart for Bresenham‟s Circle algorithm and write a C program for the same 

3. Write the advantages and disadvantages of Bresenham‟s algorithm over DDA Algorithm for 

drawing a line 

4. Write the advantages and limitations of DDA line algorithm. 

5. Determine the raster scan locations selected by Bresenham‟s algorithm while generating a line 

from (10, 10) To (30, 50). 

6. Explain in brief about the coordinate systems-MCS, WCS, SCS. 

7. List the various functions and commands of graphics mode available in C Language and explain 

in brief.  
8. Write a C-Graphics Program to draw the line from (0,0) origin to (500,500).  

 

Suggested References:  

o https://nptel.ac.in/courses/106/102/106102063/ 

o https://www.vssut.ac.in/lecture_notes/lecture1424803788.pdf 

o https://cse.iitkgp.ac.in/~pb/pb-graphics-2018.pdf 

o https://www.javatpoint.com/computer-graphics-programs 

o https://www.mycplus.com/tutorials/c-programming-tutorials/graphics-programming/ 

o https://developerinsider.co/download-turbo-c-for-windows-7-8-8-1-and-windows-10-32-64-bit-full-

screen/ ( For Downloading Turbo C) 

o https://www.youtube.com/watch?v=A3i2qFx7d5g (Video) 

o https://www.programmingsimplified.com/c/graphics.h#functions (C-Graphics Help) 

o https://www.dgp.toronto.edu/~hertzman/418notes.pdf (Lecture Notes of other Uni.) 

 

Sign of Faculty/Lab In charge:  

Rubric wise marks obtained: 
 

Rubrics 1 2 3 4 5 Total 

Marks  

 

     

  

https://nptel.ac.in/courses/106/102/106102063/
https://www.vssut.ac.in/lecture_notes/lecture1424803788.pdf
https://cse.iitkgp.ac.in/~pb/pb-graphics-2018.pdf
https://www.javatpoint.com/computer-graphics-programs
https://www.mycplus.com/tutorials/c-programming-tutorials/graphics-programming/
https://developerinsider.co/download-turbo-c-for-windows-7-8-8-1-and-windows-10-32-64-bit-full-screen/
https://developerinsider.co/download-turbo-c-for-windows-7-8-8-1-and-windows-10-32-64-bit-full-screen/
https://www.youtube.com/watch?v=A3i2qFx7d5g
https://www.programmingsimplified.com/c/graphics.h#functions
https://www.dgp.toronto.edu/~hertzman/418notes.pdf


Date:      /     /2024 

EXPERIMENT: 02 

INTRODUCTORY EXERCISE FOR 3-D MODELLING 

 

Aim: To study brief about the 3D modeling software and exercise/practice on software available. 

Tool used: Extrude, Revolve, Fillets, Champers, Ribs, Shell 

Introduction: 

3D Modeling is used in a variety of applications to make representations of physical objects 

on the computer. 3D modeling is a subset of Computer Aided Design (CAD), in which you use a 

computer to assist in the design process for any type of design work. It is used in a variety of 

applications, mostly when it comes to designing parts on the computer to assist in the making or 

visualization of those parts. The computer model is used to communicate dimensions, material types, 

etc. to anyone viewing the design, and can be used to make control paths for Computer Numerical 

Controlled (CNC) machines. 3D Modeling Services is the blend of developing a geometrical 

representation of any facet of an object or a product in three dimensions via specialized software. In 

3D Computer graphics, the product is called 3D Model. It includes 3D Modeling of an object or a 

product by manipulating polygons, circumference and vertices in simulated 3D space. 

3D Modeling in general makes the product design process more efficient. Modeling 

programs allow you to create and visualize final products, modify and optimize the designs, and 

document designs, measurements and materials easily. If you've heard of 3D printing, 3D modeling 

is what is used to design objects before they are 3D printed.  

From movies to manufacturing, 3D modeling is incredibly useful. There are hundreds of different 3D 

design programs out there, each for a specific application. 3D modeling allows engineers to flush out their 

ideas before they become reality, so most objects that you see around you were first designed in 3D design 

software by engineers before they were made. 3D design is extremely important for this reason: engineers, 

architects, and the like use 3D CAD programs to design things before building them all the time. For 

example, each component of your computer was modeled in 3D modeling software, each part's shape and cost 

was optimized for its use, and all of the models were put together in an assembly in the software to ensure that 

they all fit together properly. The files were then all sent to a manufacturer, where computer controlled 

machines were able to make all of the parts, and workers used the files to follow the assembly steps to 

physically build the computer that you have sitting in front of you. 

Working with a 3D model helps you render three-dimensional objects more realistically. That 

way, you can evaluate the design before working on the prototype. The design industry is currently seeing a 

https://www.teslamechanicaldesigns.com/3d-modeling-services.php
https://www.instructables.com/id/3D-Printing-Basics/


decline in the use of physical models, with more focus on the digital stage to reduce spending and maximize 

time. 

Arguments to move up from 2D to 3D include:  

 Better visualization: the model looks like the real live object. 

  Lesser risk for mistakes: a 3D-system will only accept spatial structures that can (geometrically) exist 

in space. 

 Faster dataflow in between steps in the design process: as all information (geometry, administrative 

and technological features) is part of the object, all this information will pass automatically to the next 

step in design or manufacturing. 

 Automated drawing extraction: spatial objects are the basis for projection views, sectioning and 

hidden line removal. 

 Faster design: editing possibilities lead to the recycling of former designs. 

Description of Tools: 

1. Extrude: The extrude tool is used to define the extrusion depth of the sketch by   

              specifying a depth value. 

 Blind Extrude: The tool is used to define the extrusion depth of the sketch by specifying a 

depth value. 

 Symmetric: The tool is used to add the material the equally in both the directions of 

the sketching plane. 

 Through All: The tool is used to set the extrusion depth of the sketch through all the 

surfaces of the model in the direction of extrusion. 

 Through until: The tool is used to select the surface up to which the sketch is to be 

extruded. 

 To next: The tool is used to set the extrusion depth of the sketch up to the next surface of the 

model in the direction of extrusion. 

2.   Revolve: The revolve tool allows you to revolve the sketched section through the specified 

angle about an axis of the coordinate system or of a geometric centerline. 

3.   Chamfers: The chamfer tool is used to bevel the selected edges and corners as per some 

specified parameters. 

 Corner chamfer: The tool is used to create a chamfer on a corner. 
 Edge chamfer: The tool is used to create a chamfer on an edge. 

4.   Ribs: Ribs are defined as thin wall like structures used to bind the joints together so that they 

do not fail under an increased load. The section for the rib is sketched as an open section and can 

be extruded equally in both directions of the sketch plane or an either side. 

5.   Fillets: The fillet tool is used to round the edges or faces of a part to a specified radius. 

6.   Shell: Shell features remove surfaces to hollow out a design model, leaving walls with 

specified thickness values. 

 

There are two parts for the creation of a basic shell feature: 
 

 Select Surface for Removal – Select the surface or surfaces want to remove from the model. 

You may decide not to remove any surfaces from the shell, which results in the creation of a 



closed shell, with the whole inside of the part hollowed out and no access to the hollow. 

 Thickness – Specify the thickness of the model walls that remain. You create shells the 

design process to support your design intent. However, be aware that several features 

could reference a shell created early in the design process. 

 

 

Exercise: Create 3-dimensional solid model using above mentioned tools in modeling software. 

1. 

 

 

 

2. 

 

 

 

 

 

 

 



3. 

 

4. 

 

 

5. 

 

 

 



6. 

 

 

Questions:  

1. Explain parametric representation? 

2. Write the difference between 2D and 3D solid modeling. 

3. List the various free and paid software for 2D Sketching and 3D part modeling. 

References: 

1. https://academy.autodesk.com/ 

2. https://www.ptc.com/en/ptc-university 

3. https://drive.google.com/file/d/1NLAKSve8OR9t87HpjKp4HeOrdNQ8WuAb/view?usp=sharing  

4. https://www.youtube.com/watch?v=ZlzwJdW-UDE  (Installation) 

5. https://www.youtube.com/watch?v=X0AMdUMNsDI (Practice) 

6. https://www.youtube.com/watch?v=BF1SZv8KhfM (Practice) 

7. https://www.youtube.com/watch?v=GS0CvBh0xW8  (Video by Faculty) 

 

 

Sign of Faculty/Lab in-charge: 

Rubrics 1 2 3 4 5 Total 

Marks  

 

     

 

 

https://academy.autodesk.com/
https://www.ptc.com/en/ptc-university
https://drive.google.com/file/d/1NLAKSve8OR9t87HpjKp4HeOrdNQ8WuAb/view?usp=sharing
https://www.youtube.com/watch?v=ZlzwJdW-UDE
https://www.youtube.com/watch?v=X0AMdUMNsDI
https://www.youtube.com/watch?v=BF1SZv8KhfM
https://www.youtube.com/watch?v=GS0CvBh0xW8


Date:      /     /2024 

EXPERIMENT: 03 

EXERCISE FOR ADVANCED 3D-MODELING  

 

Aim:  Students have to create the part files of the 3D Model of the part drawing provided. 

 

Objectives: 

•    Create an object using pattern 

•    Sketch a Trajectory for a sweep 

•    Sketch and locate a Sweep section 

 

 

Instructions: 

Students are informed to attend the video/practical hands on session in CAD laboratory for learning, 

how to create the 3D part model in the software. According to the steps learn, he/she draw the 3D Model and 

save the part file in desktop PC for the following problems. (Assume suitable dimensions where ever 

necessary) 

1. 

 

 

 

 

 

 

 

 

 

 



2. 

 

3. 

 

 

 

 

 

 

 

 

 

 

 



Questions: 

1. List the command used for making the above 3D Model part files. 

2. Take the screenshot of each step for any one problem from above for making the 3D model, and take 

printout of screenshot pdf file and also submit the soft copy PDF file of it. 

 

 

 

References: 

1. https://www.youtube.com/watch?v=KkzQoij-TJo  (Cup Modeling) 

2. https://www.youtube.com/watch?v=fWTz9Fv94_k 

3. https://www.youtube.com/watch?v=JHAZ9L5XaNE 

4. https://support.ptc.com/help/creo/creo_pma/usascii/index.html#page/tutorials_pma/online_help/aux_f

iles/pma_tutorials.html 
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EXPERIMENT: 04 

EXERCISE FOR 3D-EDITING OPTIONS  

Aim: Exercise for 3-D editing options. 
 

Tool used: Reordering, Rerouting, Suppressing, Deleting, Modifying 
 

Introduction: Editing is one of the most important aspects of solid modeling. Most of the 

design requires the editing during their creation or after they are created. 
 

Description of Tools: 
 

1.   Redefining Features: Editing the definition of features allows you to make changes in the 

parameters that were used to create it. Sketches of the sketched features can also modify 

by editing their definition. 

2.   Reordering Featured: It is defined as the process of changing the sequence of feature 

creation in a model. Sometimes after creating a model, it may be required to change the 

order in which the features of the model were created. A feature can be placed before or 

after another feature. 

3.   Rerouting Features: Rerouting of features is required when there is a need of 

changing its sketch plane. References can also redefine that were selected while 

creating the sketches. 

4.   Suppressing Features: The Suppressed feature is used to hide the features in a model. 

Once the feature is suppressed, it will neither be displayed in the drawing area nor in the 

drawing views. The feature is not deleted, only its visibility is turned off. When a model has 

many features, then suppressing some features decreases its regeneration time. 

5.   Deleting Features: The feature that is not required in the model can be deleted from the 

model. 

6.   Modifying Features: Dimensions of a model are easy to modify by using modifying 

features. 

 

Exercise:  

Create 3-Dimensional solid model and modify it using above mentioned tools in modeling 

software. 

 

 

 



 



 
 (Ref https://www.thesourcecad.com/autocad-practice-drawings-with-pdf-ebook/) 

 

Questions: 

1. How in parametric software you can edit the 3D Model? (You can take the screen shot of the steps 

also). 

2. Develop the 3D Model of the above drawing/Figure and use the “Edit Definition and Edit 

References” Option to the dimensions, references of the features of 3D Model. 

References: 

1. https://www.youtube.com/watch?v=ttMs393y8_Q 

2. https://www.youtube.com/watch?v=kRxBD-B5IrY (Edit Definition) 

3. https://www.youtube.com/watch?v=V47f--6EfFM (Edit Definition) 

4. https://www.youtube.com/watch?v=EP7WYFV1fkU (Edit References) 

5. http://support.ptc.com/help/creo/creo_pma/usascii/index.html#page/tutorials_pma%2Ftutorials_overv

iew.html%23wwconnect_header (PTC Tutorials for beginners) . 
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EXPERIMENT: 05 

EXERCISE FOR ASSEMBLY MODELLING  

 

Aim:  Students have to create the assembly files of the 3D Component, after that plot the assembly 

with dimensions. 

 

Introduction: 

CAD solid model programs use a database of primitive forms of solid geometry like cubes, 

cones, cylinders, pyramids, spheres, etc. These are combined in a variety of ways (adding or 

subtracting) to produce more complex models. 

 

Fig 5.1: Assembly modeling using operation 

This gives a well defined model. All volumes, surfaces and angles are well defined and 

known unlike surface modelers or wire frame modelers. Since all solids are represented inside the 

system as combinations of primitives or parts of primitives a task like calculating the volume of a 

complex space present few problems. It is just a question of taking the volumes of the constituent 

primitives and adding or subtracting them as appropriate. So volumes and weights are well known in 

the beginning of the design process and lead no room for misinterpretation. 

Also designers found out that building a shape up out of primitives allows them to 

concentrate on essentials. The whole process brings them closer to the actual manufacturing process, 

and is in some cases almost a literal simulation of it. The parallel between boring a hole in an object 

and subtracting a model of a cylinder from a model of that object is after all very close and adding a 

model cogwheel to a model cylinder is very like slipping a real cogwheel onto a real axle. 

The solid models are representing the geometry and can be the base for engineering analysis 

because the geometry is well defined. This integration between CAD and Engineering is very 

important in Concurrent Engineering because it makes more iteration steps possible during the 



design. So many changes during the design process are possible. This will help to optimize the 

product, which will give an increasing product quality and a reduction in the product development 

time. 

The analyzing methods that are mostly used can calculate and the mechanical, kinematics 

and dynamic behavior of the simulated software prototypes. 

The ability to develop 3-D solid models is bridging the gaps between design, engineering, 

and manufacturing in a concurrent engineering environment. To save time and costs 3-D solid model 

files are electronically transferred to molders, and used to cut tools directly (CAD/CAM); the same 

files can also be used for rendering and analysis to reduce the risk of failure. 

Assembly modeling further builds on solid modeling by combining solid part models 

together into an overall assembly model. The individual part solid model data files describing the 3D 

geometry of individual components are assembled together to create an assembly describing the 

whole product or assembly. Components can be positioned within the product assembly using 

absolute coordinate placement methods or by means of mating conditions. Mating conditions are 

definitions of the relative position of components between each other; for example alignment of two 

holes or location of two part faces to one another. Solid and assembly modeling can capture more 

than just the part geometry. Tolerance, geometric dimensioning, and notations can also be captured. 

The individual data files describing the 3D geometry of individual components are assembled 

together through a number of sub-assembly levels to create an assembly describing the whole product. 

All CAD and CPD systems support this form of bottom-up construction. Some systems, via associative 

copying of geometry between components also allow top-down method of design. 

Components can be positioned within the product assembly using absolute coordinate placement 

methods or by means of mating conditions. Mating conditions are definitions of the relative position of 

components between each other; for example alignment of axis of two holes or distance of two faces from one 

another. The final position of all components based on these relationships is calculated using a geometry 

constraint engine built into the CAD or visualization package. 

Assembly: 

 

1.   Top down approach: This is the method of assembling the components in which the 

components of the assembly are created in the same assembly file. In this type of 

assembly modeling approach, the components are created in the assembly file and then 

assembled using the assembly constraints. 

2.   Bottom down approach: This is the method of assembling the components that are 

created as separate parts in the part mode. Once all parts of an assembly have been 

created, you will create a new assembly file and then assemble the parts using the 

assembly constraints. 

 

Exercise: Create all the components of Knuckle Joint and assemble them as shown in figure. The 

dimension of all the components is given in figure below 

 



 

Questions: 

1. What is the difference between top down and bottom-up approach? 

2. Develop the 3D Assembly of any one component in the solid modeling software and plot with  

               dimension on sheet. 

References: 

1. https://www.npd-solutions.com/solid-modeling.html 

2. https://www.youtube.com/watch?v=3Td6VqUxunQ&t=224s 

3. https://www.youtube.com/watch?v=6E05PBZ0ySY 

4.    

https://www.youtube.com/watch?v=6FZ5XxF4hZs&list=PL8MELgWj0RxO5hLAyfg1ka8qW8Q26Kpfx  

5. https://nptel.ac.in/courses/112/102/112102101/ 

6.https://www.ccri.edu/faculty_staff/engt/jsrobinson/Spring%202016%20Transfer/ENGR%201030%20S

pring%202016/ENGR%201030%20Fall%202015/SWG2015.pdf 

7. http://www.cad-resources.com/CREO_Parametric/Creo_Parametric_Download_Lessons-       

Projects/CREO_Projects_Download.pdf 

8. http://www.cad-resources.com/ 

 

Sign of Faculty/Lab In charge:  

 

Rubrics 1 2 3 4 5 Total 

Marks  

 

     

https://www.npd-solutions.com/solid-modeling.html
https://www.youtube.com/watch?v=3Td6VqUxunQ&t=224s
https://www.youtube.com/watch?v=6E05PBZ0ySY
https://www.youtube.com/watch?v=6FZ5XxF4hZs&list=PL8MELgWj0RxO5hLAyfg1ka8qW8Q26Kpfx
https://nptel.ac.in/courses/112/102/112102101/
https://www.ccri.edu/faculty_staff/engt/jsrobinson/Spring%202016%20Transfer/ENGR%201030%20Spring%202016/ENGR%201030%20Fall%202015/SWG2015.pdf
https://www.ccri.edu/faculty_staff/engt/jsrobinson/Spring%202016%20Transfer/ENGR%201030%20Spring%202016/ENGR%201030%20Fall%202015/SWG2015.pdf
http://www.cad-resources.com/CREO_Parametric/Creo_Parametric_Download_Lessons-%20%20%20%20%20%20%20Projects/CREO_Projects_Download.pdf
http://www.cad-resources.com/CREO_Parametric/Creo_Parametric_Download_Lessons-%20%20%20%20%20%20%20Projects/CREO_Projects_Download.pdf
http://www.cad-resources.com/


Date:      /     /2024 

 

EXPERIMENT: 06 

 

Exercise for FEA of 1-D structural problems. 

 

Aim:  Students have to solve the 1-D Structural problem in ANSYS Software. 

 

Introduction: 

The Finite Element Method (FEM) is a numerical technique to find approximate solutions of partial 

differential equations. It was originated from the need of solving complex elasticity and structural analysis 

problems in Civil, Mechanical and Aerospace engineering. In a structural simulation, FEM helps in producing 

stiffness and strength visualizations. It also helps to minimize material weight and its cost of the structures. 

FEM allows for detailed visualization and indicates the distribution of stresses and strains inside the body of a 

structure. Many of FE software are powerful yet complex tool meant for professional engineers with the 

training and education necessary to properly interpret the results. Several modern FEM packages include 

specific components such as fluid, thermal, electromagnetic and structural working environments. FEM 

allows entire designs to be constructed, refined and optimized before the design is manufactured. This 

powerful design tool has significantly improved both the standard of engineering designs and the 

methodology of the design process in many industrial applications. The use of FEM has significantly 

decreased the time to take products from concept to the production line. One must take the advantage of the 

advent of faster generation of personal computers for the analysis and design of engineering product with 

precision level of accuracy. 

 

Background of Finite Element Analysis: 

The finite element analysis can be traced back to the work by Alexander Hrennikoff (1941)and Richard 

Courant(1942). Hrenikoff introduced the framework method, in which a plane elastic medium was 

represented as collections of bars and beams. These pioneers share one essential characteristic: mesh 

discretization of a continuous domain into a set of discrete sub-domains, usually called elements.  

 In 1950s, solution of large number of simultaneous equations became possible because of the digital 

computer. 

 In 1960, Ray W. Clough first published a paper using term “Finite Element Method”. 

 In 1965, First conference on “finite elements” was held. 

 In 1967, the first book on the “Finite Element Method” was published by Zienkiewicz and Chung.  



 In the late 1960s and early 1970s, the FEM was applied to a wide variety of engineering problems. 

 In the 1970s, most commercial FEM software packages (ABAQUS, NASTRAN, ANSYS, etc.) 

originated. Interactive FE programs on supercomputer lead to rapid growth of CAD systems. 

 In the 1980s, algorithm on electromagnetic applications, fluid flow and thermal analysis were 

developed with the use of FE program. 

 Engineers can evaluate ways to control the vibrations and extend the use of flexible, deployable 

structures in space using FE and other methods in the 1990s. Trends to solve fully coupled solution of 

fluid flows with structural interactions, bio-mechanics related problems with a higher level of 

accuracy were observed in this decade. 

 

The formulation for structural analysis is generally based on the three fundamental relations: 

equilibrium, constitutive and compatibility. There are two major approaches to the analysis: Analytical and 

Numerical. Analytical approach which leads to closed-form solutions is effective in case of simple geometry, 

boundary conditions, loadings and material properties. However, in reality, such simple cases may not arise. 

As a result, various numerical methods are evolved for solving such problems which are complex in nature. 

For numerical approach, the solutions will be approximate when any of these relations are only approximately 

satisfied. The numerical method depends heavily on the processing power of computers and is more 

applicable to structures of arbitrary size and complexity. It is common practice to use approximate solutions 

of differential equations as the basis for structural analysis. This is usually done using numerical 

approximation techniques. Few numerical methods which are commonly used to solve solid and fluid 

mechanics problems are given below. 

• Finite Difference Method  

• Finite Volume Method 

• Finite Element Method  

• Boundary Element Method  

• Mesh less Method 

 

Concepts of Elements and Nodes: 

Any continuum/domain can be divided into a number of pieces with very small dimensions. These 

small pieces of finite dimension are called „Finite Elements‟ (Fig. 6.1). A field quantity in each element is 

allowed to have a simple spatial variation which can be described by polynomial terms. Thus the original 

domain is considered as an assemblage of number of such small elements. These elements are connected 

through number of joints which are called „Nodes‟. While discretizing the structural system, it is assumed that 

the elements are attached to the adjacent elements only at the nodal points. Each element contains the material 

and geometrical properties. The material properties inside an element are assumed to be constant. The 

elements may be 1D elements, 2D elements or 3D elements. The physical object can be modeled by choosing 

appropriate element such as frame element, plate element, shell element, solid element, etc. All elements are 



then assembled to obtain the solution of the entire domain/structure under certain loading conditions. Nodes 

are assigned at a certain density throughout the continuum depending on the anticipated stress levels of a 

particular domain. Regions which will receive large amounts of stress variation usually have a higher node 

density than those which experience little or no stress. 

 

 

Fig. 6.1 Finite element discretization of a domain 

 

Degrees of Freedom: 

A structure can have infinite number of displacements. Approximation with a reasonable level of 

accuracy can be achieved by assuming a limited number of displacements. This finite number of 

displacements is the number of degrees of freedom of the structure. For example, the truss member will 

undergo only axial deformation. Therefore, the degrees of freedom of a truss member with respect to its own 

coordinate system will be one at each node. If a two dimension structure is modeled by truss elements, then 

the deformation with respect to structural coordinate system will be two and therefore degrees of freedom will 

also become two. The degrees of freedom for various types of element are shown in Fig. 6.2 for easy 



understanding. Here (u,v,w) and (ɵx,ɵy,ɵz) represent displacement and rotation respectively. 

 

Fig. 6.2 Degrees of Freedom for Various Elements 

 

Advantages of FEA: 

• The physical properties, which are intractable and complex for any closed bound solution, can    be 

analyzed by this method. 

• It can take care of any geometry (may be regular or irregular). 

• It can take care of any boundary conditions. 

• Material anisotropy and non-homogeneity can be catered without much difficulty. 

• It can take care of any type of loading conditions. 

• This method is superior to other approximate methods like Galerkine and Rayleigh-Ritz methods. 

• In this method approximations are confined to small sub domains. 

• In this method, the admissible functions are valid over the simple domain and have nothing to do with 

boundary, however simple or complex it may be. 



• Enable to computer programming. 

 

Disadvantages of FEA 

• Computational time involved in the solution of the problem is high. 

• For fluid dynamics problems some other methods of analysis may prove efficient than the FEM. 

• Proper engineering judgment is to be exercised to interpret results. 

• It requires large computer memory and computational time to obtain intend results. 

• There are certain categories of problems where other methods are more effective, e.g., fluid problems 

having boundaries at infinity are better treated by the boundary element method. 

• For some problems, there may be a considerable amount of input data. Errors may creep up in their 

preparation and the results thus obtained may also appear to be acceptable which indicates deceptive 

state of affairs. It is always desirable to make a visual check of the input data. 

• In the FEM, many problems lead to round-off errors. Computer works with a limited number of digits 

and solving the problem with restricted number of digits may not yield the desired degree of accuracy or 

it may give total erroneous results in some cases. For many problems the increase in the number of 

digits for the purpose of calculation improves the accuracy. 

 

 

 

This experiment has given the following skills. 

 
1.   The ability to model 1-D problems in ANSYS. 

2.   The ability to adapt element types to specific situations by suppressing degrees of freedom 

(we used a 3D element as a 1D element). 

3.   The ability to generate finite element models using the direct method (i.e. defining nodes and 

then defining elements linking those nodes, as opposed to taking a solid model and dividing it up 

into elements which we will do in subsequent tutorials). 

4.   The ability to define element types, real constants and material parameters for a finite element 

model. 

5.   The ability to apply boundary conditions and loads to specific nodes in a finite element 

model. 

6.   The ability to run a simple linear static analysis. 

7.   The ability to list displacement results for each node in the finite element model. 

8.   The ability to create an element table to obtain additional results from a finite element model 

and to list these results. 



9.   Experience in comparing the results obtained from your finite element model with other 

results and validating your results against the other results. 

 

 
 

 

 Solve the tutorials as given below and compare with results of software. 

Problem Statement: 

Find Total  Displacement, Stress in the Element & Reaction Forces for the 

following  Problem using Link 1 Element. 

Given Data 

E=2.1x 105N/ mm2
 

0.3 (Poison's Ratio). 

 

 

 

Overview 

 

In this tutorial we will examine the 1-D displacement of a shaft in tension using 

ANSYS.. You will determine the displacement distribution and stress distribution in the bar due 

to the applied loading and boundary conditions. A one-dimensional structural truss element 

(often also called a "spar", "spring" or "link" element) will be used for this analysis. We will use 

SI system units for this tutorial: 

 

Procedure 

 

Step 1: create geometry 

 

Use any modeling software(solid works, nx, fusion 360 etc.) or inbuilt space clam module to 

create the model of the problem 

Make sure to save the model file as IGES/IGS format to successfully import the model into 

Ansys workbench 
 
 



 

Step 2:open Ansys workbench and drag static structural module into project schematic 

 



 

 

 

Step 3: add material 

  Double click on engineering data ,then click on the blank box which says “click here tp add 

a new material ” and put the name of the material there. After that on left side go on linear Elastic 

properties and drag and drop “Isotropic Elasticity ” on your material then put values of poisson‟s 

ratio and young‟s modulus (E) in yellow boxes (to add exponential values use “e” ex.50000=5e4 ) 

 



Step4: add geometry 

 

To add geometry right click on geometry>import geometry>browse and then locate your file 

where you saved your geometry 

 

Step 5: open design modeler and generate mesh 

 

After importing the geometry double click on the “Model ” to open design modeler. On the left 

side on the  “outline” space right click on the “mesh” then “generate mesh” 

 

Step 6: assigning material 

 

Click on the plus icon near “geometry” then select the geometry, then on the bottom left go to the 

material and change it to the defined material using the arrow on the right side 

 

 

 



 

 

 

 

Step 7: boundary conditions 

Right click on the static structural>insert then click on the “fixed support” 

 

 

Then select the face and press apply to give boundary condition 

 

 

Similarly give force and the magnitude of the force in bottom left details box and set the 

direction of the force 



 

 

 
 

Step 8:solve the problem 

Right click on solution then insert>deformation>total deformation and insert>stress>von- 

mises stress after selection them right click on solution and then solve 



 
 

Step 9: Examine the Results 

To see the results click on the total deformation and equivalent stress to see the results 

 

 

 



 

 

Max Stress in Element 9.35x 10^5 Pa 

Min Stress in Element 4.026x 10^5 Pa 

Total deformation 1.0869m 

Problem 1: 

A steel rod subjected to compression is modeled by two bar elements, as shown in Figure. . Using the steps 

and references learned solve the problem in Ansys Mechanical APDL. Calculate the Deformation Value, 

Stresses in axial direction and also capture the image of the result. E=207GPa, A = 500 mm2 

 

 

 

Result Table: 

 



Questions: 

1. Write the basic steps in Finite Element Analysis? 

2. List the Finite element analysis software available commercially and freely? 

3. List and draw the element types in Ansys Software with details? 

4. Write down brief history of Finite Element Method (FEM)? 

5. Solve the problem of 1-D Structural in Ansys or in any other analysis software? 

References: 

1. https://www.youtube.com/watch?v=TWEQWnXGQHU 

2. https://nptel.ac.in/courses/112/104/112104193/ (FEA Course) 

3. https://nptel.ac.in/courses/105/105/105105041/ (FEA Course) 

4. http://mech.iust.ac.ir/files/mech/madoliat_bcc09/pdf/yijun_liu___nummeth_20040121_fem.pdf 

5. https://www.youtube.com/watch?v=v5hr0Cb9CdQ 

6. https://www.youtube.com/watch?v=TWEQWnXGQHU 

7. https://www.cae.tntech.edu/~chriswilson/FEA/ANSYS/ANSYSguide_fea-concepts.pdf 

8. https://www.youtube.com/watch?v=AE29Dnc6j94 (In Creo) 

9. https://drive.google.com/drive/folders/1-s72t2HJxD2FUk7hzssXWf_a9TUIuEzw?usp=share_link  

10. https://www.youtube.com/watch?v=DBtFzp1-EGM  

11. https://www.ansys.com/training-center/course-catalog/structures/introduction-to-ansys-mechanical-

apdl  

12. https://www.youtube.com/watch?v=VJxxnmpVWac (ANSYS TUTOR CHANNEL) 

13. https://www.youtube.com/watch?v=olw0ADO3RPo   

14. https://www.youtube.com/watch?v=kx1jdxzDXVQ (Example Video for Help) 
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EXPERIMENT: 07 

 

Exercise for FEA of trusses 

Aim:  Students have to solve the truss structural problem in ANSYS Software. 

 

Introduction: 

A truss is a structure that consists of members organized into connected triangles so that the 

overall assembly behaves as a single object. Trusses are most commonly used in bridges, roofs and towers. 

A truss is made up of a web of triangles joined together to enable the even distribution of weight and 

the handling of changing tension and compression without bending or shearing. The triangle is geometrically 

stable when compared to a four (or more) -sided shape which requires that the corner joints are fixed to 

prevent shearing. 

Trusses consist of triangular units constructed with straight members. The ends of these members are 

connected at joints, known as nodes. They are able to carry significant loads, transferring them to 

supporting structures such as load-bearing beams, walls or the ground. 

In general, trusses are used to: 

 Achieve long spans. 

 Minimize the weight of a structure. 

 Reduced deflection. 

 Support heavy loads. 

Trusses are typically made up of three basic elements: 

 A top chord which is usually in compression. 

 A bottom chord which is usually in tension. 

 Bracing between the top and bottom chords. 

The top and bottom chords of the truss provide resistance to compression and tension and so resistance to 

overall bending, whilst the bracing resists shear forces. The efficiency of trusses means that they require 

less material to support loads compared with solid beams. Generally, the overall efficiency of a truss is 

optimized by using less material in the chords and more in the bracing elements. 

Trusses are structures that are composed entirely of two-force members. Each member of a truss is assumed 

to be a straight member that can only have forces applied on the ends of that member. The ends are pinned 

together so that they allow rotation. A simple truss might look like this: 

 

 

Fig 7.1 Truss  
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Fig7.1 Truss Example (Application) Ref: https://www.civil.iitb.ac.in/~minamdar  

Problem Description: 

Determine the nodal deflections, reaction forces, and stress for the truss system shown below (E = 200GPa, A 

= 3250mm
2
). 

 
Fig7.2 Truss problem with dimensions 

(Ref: Chandrupatla & Belegunda, Introduction to Finite Elements in Engineering) 

 

Preprocessing: Defining the Problem 

 
1. Give the Simplified Version a Title (such as 'Bridge Truss Tutorial'). 

In the Utility menu bar select File > Change Title: 



 
 

The following window will appear: 

 
 

Enter the title and click 'OK'. This title will appear in the bottom left corner of the 'Graphics' Window once 

you begin.  

Note: to get the title to appear immediately, select Utility Menu > Plot > Replot 

 

2. Enter Keypoints 

 

The overall geometry is defined in ANSYS using key points which specify various principal coordinates to 

define the body. For this example, these key points are the ends of each truss. 

We are going to define 7 key points for the simplified structure as given in the following table 

 
Table 7.1 – Key points coordinates 

 

From the 'ANSYS Main Menu' select: 

Preprocessor > Modeling > Create > Keypoints > In Active CS 

 

 



 

The following window will then appear: 

 

 
 

To define the first key point which has the coordinates x = 0 and y = 0: 

Enter key point number 1  in the appropriate box, and enter the x,y coordinates: 0, 0 in their 

appropriate boxes (as shown above). 

Click 'Apply' to accept what you have typed. 

Enter the remaining key points using the same method. 

Note: When entering the final data point, click on 'OK' to indicate that you are finished entering key points. If 

you first press 'Apply' and then 'OK' for the final key point, you will have defined it twice! If you did press 

'Apply' for the final point, simply press 'Cancel' to close this dialog box.  

Units 

Note the units of measure (ie mm) were not specified. It is the responsibility of the user to ensure that a 

consistent set of units are used for the problem; thus making any conversions where necessary. 

 

Correcting Mistakes 

When defining key points, lines, areas, volumes, elements, constraints and loads you are bound to make 

mistakes. Fortunately these are easily corrected so that you don't need to begin from scratch every time an 

error is made! Every 'Create' menu for generating these various entities also has a corresponding 'Delete' 

menu for fixing things up. 

 

3. Form Lines 

The key points must now be connected 

We will use the mouse to select the key points to form the lines. 
 

In the main menu select: Preprocessor > Modeling > Create > Lines > Lines > In Active Coord. 

The following window will then appear: 



 
 

Now move the mouse toward key point #2.  

A line will now show on the screen joining these two points. Left click and a permanent line will appear. 

Connect the remaining key points using the same method. 

 

When you're done, click on 'OK' in the 'Lines in Active Coord' window, minimize the 'Lines' menu 

and the 'Create' menu. Your ANSYS Graphics window should look similar to the following figure. 

 
 

Disappearing Lines 

Please note that any lines you have created may 'disappear' throughout your analysis. However, they have 

most likely NOT been deleted. If this occurs at any time from the Utility Menu select: Plot > Lines 

 

4. Define the Type of Element 



It is now necessary to create elements. This is called 'meshing'. ANSYS first needs to know what kind of 

elements to use for our problem: From the Preprocessor Menu, select: Element Type > Add/Edit/Delete. 

The following window will then appear: 

 

 
 

Click on the 'Add...' button. The following window will appear: 

 

 
 

For this example, we will use the 2D spar element as selected in the above figure. Select the Element shown 

and click 'OK'. You should see 'Type 1 LINK1' in the 'Element Types' window. Click on 'Close' in the 

'Element Types' dialog box. 

 

5. Define Geometric Properties 

We now need to specify geometric properties for our elements: 

In the Preprocessor menu, select Real Constants > Add/Edit/Delete 



 
 

Click Add... and select 'Type 1 LINK1' (actually it is already selected). Click on 'OK'. The 

following window will appear: 

 

 
 

Above window is optional , in newer version not require based on element selection type. As shown in the 

window above, enter the cross-sectional area (3250mm):  

Click on 'OK'. 

'Set 1' now appears in the dialog box. Click on 'Close' in the 'Real Constants' window. 

 

6. Element Material Properties 

 

You then need to specify material properties: 

In the 'Preprocessor' menu select Material Props > Material Models 



 
 

Double click on Structural > Linear > Elastic > Isotropic 

 

 
 

We are going to give the properties of Steel. Enter the following field: EX = 2e5  

Set these properties and click on 'OK'. Note: You may obtain the note 'PRXY will be set to 0.0'. This is 

poisson's ratio and is not required for this element type. Click 'OK' on the window to continue. Close the 

"Define Material Model Behavior" by clicking on the 'X' box in the upper right hand corner. 

7. Mesh Size 

The last step before meshing is to tell ANSYS what size the elements should be. There are a variety of ways 

to do this but we will just deal with one method for now. � In the Preprocessor menu select Meshing > Size 

Cntrls > ManualSize > Lines > All Lines 

 
 

In the size 'NDIV' field, enter the desired number of divisions per line. For this example we want only 1 

division per line, therefore, enter '1' and then click 'OK'. Note that we have not yet meshed the geometry, we 

have simply defined the element sizes.  



 

8. Mesh Now the frame can be meshed. In the 'Preprocessor' menu select Meshing > Mesh > Lines and click 

'Pick All' in the 'Mesh Lines' Window Your model should now appear as shown in the following  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Plot Numbering 

To show the line numbers, keypoint numbers, node numbers... 

From the Utility Menu (top of screen) select PlotCtrls > Numbering... 

Fill in the Window as shown below and click 'OK' 

 
 

Now you can turn numbering on or off at your discretion Saving Your Work 

Save the model at this time, so if you make some mistakes later on, you will at least be able to come back to 

this point. To do this, on the Utility Menu select File > Save as.... Select the name and location where you 

want to save your file. 

It is a good idea to save your job at different times throughout the building and analysis of the model to 

backup your work in case of a system crash or what have you. 

 

 

 

 



Solution Phase: Assigning Loads and Solving 
You have now defined your model. It is now time to apply the load(s) and constraint(s) and solve the 

the resulting system of equations. Open up the 'Solution' menu (from the same 'ANSYS Main 

Menu'). 

 

1. Define Analysis Type 

 

First you must tell ANSYS how you want it to solve this problem: 

From the Solution Menu, select Analysis Type > New Analysis. 

 
 

Ensure that 'Static' is selected; i.e. you are going to do a static analysis on the truss as opposed to a 

dynamic analysis, for example. 

Click 'OK'. 

 

2. Apply Constraints 

It is necessary to apply constraints to the model otherwise the model is not tied down or grounded 

and a singular solution will result. In mechanical structures, these constraints will typically be fixed, 

pinned and roller-type connections. As shown above, the left end of the truss bridge is pinned while 

the right end has a roller connection. 

 

In the Solution menu, select Define Loads > Apply > Structural > Displacement > On Keypoints 

 

 
 

Select the left end of the bridge (Keypoint 1) by clicking on it in the Graphics Window and click on 

'OK' in the 'Apply U,ROT on KPs' window. 

 



 
 

This location is fixed which means that all translational and rotational degrees of freedom (DOFs) 

are constrained. Therefore, select 'All DOF' by clicking on it and enter '0' in the Value field and click 

'OK'. 

You will see some blue triangles in the graphics window indicating the displacement constraints. 
 

Using the same method, apply the roller connection to the right end (UY constrained). Note that 

more than one DOF constraint can be selected at a time in the "Apply U,ROT on KPs" window. 

Therefore, you may need to 'deselect' the 'All DOF' option to select just the 'UY' option. 

 

3. Apply Loads 

 

As shown in the diagram, there are four downward loads of 280kN, 210kN, 280kN, and 360kN at 

keypoints 1, 3, 5, and 7 respectively. 

 

Select Define Loads > Apply > Structural > Force/Moment > on Keypoints. 

 

Select the first Keypoint (left end of the truss) and click 'OK' in the 'Apply F/M on KPs' window. 

 
 

Select FY in the 'Direction of force/mom'. This indicate that we will be applying the load in the 'y' 

Direction Enter a value of -280000 in the 'Force/moment value' box and click 'OK'. Note that we are 

using units of N here, this is consistent with the previous values input. 

The force will appear in the graphics window as a red arrow. Apply the remaining loads in the same 

manner. 

The applied loads and constraints should now appear as shown below. 



 
 

4. Solving the System 

 

We now tell ANSYS to find the solution: 

 

In the 'Solution' menu select Solve > Current LS. This indicates that we desire the solution under 

the current Load Step (LS). 

 

 
 

The above windows will appear. Ensure that your solution options are the same as shown above and 

click 'OK'. 

Once the solution is done the following window will pop up.  

Click 'Close' and close the /STATUS 

 

 



 

1. Hand Calculations 

We will first calculate the forces and stress in element 1 (as labeled in the problem description). 

 

 
 

2. Results Using ANSYS 

 

Reaction Forces 

A list of the resulting reaction forces can be obtained for this element 

� from the Main Menu select General Postproc > List Results > Reaction Solution 

 

 
 

Select 'All struc forc F' as shown above and click 'OK' 

 

 
 

These values agree with the reaction forces calculated by hand above. 



 

Deformation 

 

 In the General Postproc menu, select Plot Results > Deformed Shape. The following window will 

appear. 

 

 
 

Select 'Def + undef edge' and click 'OK' to view both the deformed and the un deformed object. 

 

 
 

Observe the value of the maximum deflection in the upper left hand corner (DMX=7.409). One 

should also observe that the constrained degrees of freedom appear to have a deflection of 0 (as 

expected!) 

 

Deflection 

 

For a more detailed version of the deflection of the beam, 

From the 'General Postproc' menu select Plot results > Contour Plot > Nodal Solution. The 

following window will appear. 

 



 
 

 

Select 'DOF solution' and 'USUM' as shown in the above window. Leave the other selections as the 

default values. Click 'OK'. 

 

 
 

Looking at the scale, you may want to use more useful intervals. From the Utility Menu select Plot 

Controls > Style > Contours > Uniform Contours... 

Fill in the following window as shown and click 'OK'. 

 



 
 

You should obtain the following. 

 

 
 

The deflection can also be obtained as a list as shown below. General Postproc > List Results > 

Nodal Solution select 'DOF Solution' and 'ALL DOFs' from the lists in the 'List Nodal Solution' 

window and click 'OK'. This means that we want to see a listing of all degrees of freedom from the 

solution. 



 
 

Are these results what you expected? Note that all the degrees of freedom were constrained to zero 

at node 1, while UY was constrained to zero at node 7. 

If you wanted to save these results to a file, select 'File' within the results window (at the upper left 

hand corner of this list window) and select 'Save as'. 

 

Axial Stress 

For line elements (ie links, beams, spars, and pipes) you will often need to use the Element Table to 

gain access to derived data (ie stresses, strains). For this example we should obtain axial stress to 

compare with the hand calculations. The Element Table is different for each element, therefore, we 

need to look at the help file for LINK1 (Type help link1 into the Input Line). From Table 1.2 in the 

Help file, we can see that SAXL can be obtained through the ETABLE, using the item 'LS,1' 
 

From the General Postprocessor menu select Element Table > Define Table 

 

Click on 'Add...' 

 

 
 

As shown above, enter 'SAXL' in the 'Lab' box. This specifies the name of the item you are defining. 

Next, in the 'Item,Comp' boxes, select 'By sequence number' and 'LS,'. Then enter 1 after LS, in the 

selection box 

 

Click on 'OK' and close the 'Element Table Data' window. 

Plot the Stresses by selecting Element Table > Plot Elem Table 

The following window will appear. Ensure that 'SAXL' is selected and click 'OK' 

 



 
 

Because you changed the contour intervals for the Displacement plot to "User Specified" – you need 

to switch this back to "Auto calculated" to obtain new values for VMIN/VMAX. 

Utility Menu > PlotCtrls > Style > Contours > Uniform Contours ... 

 

 
 

Again, you may wish to select more appropriate intervals for the contour plot  

List the Stresses 

 From the 'Element Table' menu, select 'List Elem Table' 

 From the 'List Element Table Data' window which appears ensure 'SAXL' is highlighted 

 Click 'OK' 

 



 
 

Note that the axial stress in Element 1 is 82.9MPa as predicted analytically. The above are the steps 

to solve the Truss problem in Anysys using the APDL module. Try to solve any two book problem 

in Ansys  

 

Instructions: 

Students are informed to attend the video/practical hands on session in CAD laboratory for learning, 

how to create and analyze the truss in the software. According to the steps mention above practice 

the truss in Ansys software. 

 

Questions: 

1. A four bar truss as shown in figure below. Assuming that each element having the cross-

sectional area is 400mm
2
 and modulus of elasticity is 200GPa.Determine the deflections, 

reaction forces and stresses in each elements. 

 
2. Consider the similar data of above question and solve the following truss problem 



 
3. List the types of trusses and its brief? 

References: 

1. https://www.youtube.com/watch?v=cEr9MnnXME0 (2D truss problem in Workbench) 

2. https://www.youtube.com/watch?v=lXFN0-yLAl0 (Truss analysis using the APDL Ansys) 

3. http://web.engr.uky.edu/~gebland/CE%20382/CE%20382%20Four%20Slides%20per%20P

age/L5%20-%20Truss%20Structures.pdf 

4. http://www.steel-insdag.org/TeachingMaterial/chapter27.pdf 

5. https://www.civil.iitb.ac.in/~minamdar/ce102/Files/Trusses.pdf  

6. https://www.sjsu.edu/people/steven.vukazich/docs/160.4.1%20Trusses.pdf 

7. https://www.youtube.com/watch?v=s3xKv5QussM  

8. https://www.youtube.com/watch?v=lzl1_NxgsaY  
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Date:      /     /2024 

EXPERIMENT: 08 

 

Exercise for FEA using Beam Element 

Aim:  Students have to solve the cantilever beam structural problem in ANSYS Software 

 

Objective: 

•    Create beam-meshable geometry. 

•    Create standard beam cross-sections. 

•    Create beam meshes. 

•    Define beam offset and orientation. 

•    Override the mesh display. 

•    Create a local coordinate system. 

•    Request element forces and solve the model. 

•    Calculate complete beam stress components. 

•    Create a beam cross-section display 
 

 

Problem Statement: 
 

Solve the following data for Finite Element Analysis of a  Cantilever beam: 

Material : structural steel , find total  deformation and stress 

 
Step1: 

Create the given geometry in any modeling software of your choice and save 

the file in IGES/IGS format. 

 

Step 2: 

open ansys workbench, drag and drop the static structural module onto project 

schematic and  import the geometry(because static structural is default material 

we do not have to select material form engineering data) 



 

Step 3 : 

 

open the modeler and right click on the “mesh” icon, left side on the outline 

tree, and then click on “generate mesh” 

 

 

Step 4 : boundary conditions 

Right click on static structural then insert>fixed support 



 

Then select the  face and then apply the support 

 

Similarly apply force on the  edge of the beam 

 



 

 

Step5: solve the problem ,  right click on solution>insert>deformation>total 



 

Similarly , right click on solution>insert>stress>equivalent stress 

 

Then click on the “solve “ icon 

 

 

 

 

 

 



Step6 : results 

Total deformation 

 

 

Conclusion:



 

References: 

1. https://www.youtube.com/watch?v=1e4pAYXFWLo 

2. https://www.youtube.com/watch?v=3Ct0eVArooU 

3. https://my.eng.utah.edu/~me7540/ANSYS_intro2.pdf (From ansys manual) 

4. https://www.engr.uvic.ca/~mech410/lectures/FEA_Theory.pdf 

5. https://drive.google.com/file/d/1adyPlBFbT_Q6hkhvbHCBcgCHy8PafpWD/view?usp=shar

ing 

6. https://www.youtube.com/watch?v=-qNFGxjXx-s (Beam Element Video) 

7. https://www.youtube.com/watch?v=L9rwxJ7SLqw (Beam Element FEA Ansys Video) 

8. https://www.youtube.com/watch?v=0Jrh3k34dNQ  
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Date:      /     /2024 

EXPERIMENT: 09 

 

Exercise for FEA of 1D thermal problems 

Aim:  Students have to solve the 1D thermal problem in ANSYS Software. 

 

Objective: 
 

•  Create a convection boundary condition     
• Create a cylindrical coordinate system. 

• Create a spatially varying temperature constraint. 
• Plot temperature variation. 
• Use thermal results in a structural solution. 

Problem Statement: 

For a composite slab perform steady state thermal 1-D Finite Element 

Analysis. Procedure: 

Step 1: create any geometry of your choice with multiple materials/bodies and save the 

file 

in IGES/IGS format 

 

Step2: open Ansys Workbench, select “steady-state thermal” analysis system and drag and 

drop it onto project schematic and import the geometry 



 
 

Step3: double click on engineering data and go to engineering data sources on upper left 

corner 

 
 

Then select materials of your choice 

Here from thermal materials, aluminum and cast iron is selected 

To add them click on the yellow “+” icon besides them 

 



 

 

 

After selecting close the engineering data tab from upper left corner 

Step 4:open  modeler from ”model” and generate mesh  by right clicking on 

“mesh“ in outline tree 

 

 



 

Step5:to add materials, click on the “+” near geometry in outline tree then select the 

geometry portion. On bottom left corner detail box will appear for that part and there in 

”material” select the material of choice  for each segment 

 

Step6: boundary conditions 

Right click  on “steady state thermal ” then insert and select the boundary 

condition of choice. here temperature on two faces are given as boundary 

condition 

 



 

One face is set at 25
0
 and other side is set at 100

0
  

 

Step 7: solution , right click on “solution”>insert> temperature to measure temperature 

variation in the body  then click on solve to solve the problem 

 

 



 

Step 8: results 

 

 

 

 

 

 

 

 



Conclusion: 

 

References: 

1. https://www.youtube.com/watch?v=DXhpDia5RPk (1D Thermal) 

2. https://www.youtube.com/watch?v=oHYVzAih_VM 

3. https://www.youtube.com/watch?v=pA2th222ej4 (Composite Wall, Cylinder and Sphere) 

4. https://www.youtube.com/watch?v=miI1tl7jyBQ  

5. Book : Finite element methods  , by C.R.Alavala 

6. https://drive.google.com/file/d/1aOUppYEd7UMLLEvW_OTBNSXfQ24ivvN9/view?usp=s

haring 
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Date:      /     /2024 

EXPERIMENT: 10 

 

Exercise for FEA of 2-D structural problems 

Aim:  Students have to solve the 2D structural problem using ANSYS Software. 

 

Objective: 

•    Create a new part from Parasolid geometry. 

•    Define boundary conditions. 

•    Solve the model. 

•    Display the results. 

 

Problem Statement: 

Find total deformation and von-mises stress of given square plate 

Material: structural steel 

Thickness of the plate=0.01m 

Hole diameter=0.025m 

 

Procedure: 

Step1: create geometry and save it in IGES/IGS format. 



 

Step 2: open Ansys, drag and drop “static structural” Analysis system onto the 

project schematic and import the geometry 

 

Step3: open modeler and generate the mesh from outline tree “mesh” option 



 

Step 4: adding boundary conditions, right click on “static structural”>insert>fixed 

support then select the face to be fixed and apply. 

 

Similarly apply force in the desired face 



 

Step5: solve the problem, right click on “solution ”>insert>deformation>total 

and insert>stress>equivalent stress and then click on the “solve” 

 



 

Step6: 

results 

stress 

 

 

 

 

 

 

 



 

Deformation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Conclusion: 

 

 

 

References: 

1. http://web.engr.uky.edu/~gebland/CE%20382/CE%20382%20Structural%20Analysis%20H

andout%20Notes.pdf 

2. https://www.youtube.com/watch?v=FtyTU5DOZtQ  (Ansys Workbench 2D Plain stress of 

bracket) 

3. https://www.youtube.com/watch?v=qnIu2__6aAY 

4. http://fea-cae-engineering.com/fea-cae-engineering/element_types.htm  

5. http://mae.uta.edu/~lawrence/ansys/ansys_examples.htm  

6. https://www.youtube.com/watch?v=kcdbB0wJBXM 

7. Ref: University of Alberta (Ansys Tutorial) 
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EXPERIMENT: 11 

 

Exercise for developing the optimization model of machine element using 

Johnson Method. 

 

Aim:  Students have to develop the optimization model for the problem given. 

1. Introduction: Adequate design and Optimum design and the differences. 
 

Adequate design: 
 

Adequate design is the selection of material & the values for independent 

geometrical parameters for a mechanical element such that the mechanical element 

satisfies its function requirement & the undesirable effects are kept in tolerable 

limit. For example, if one wants to design a shaft for a machine. The material for the 

shaft will be selected from the list of feasible materials and the geometrical 

parameter (Día of shaft) will be determined on the basis of strength equation based 

on stress or rigidity. One will get different sizes for the different materials chosen. 

All such designs are known as adequate design. 

 

      Optimum Design: 

Optimum design is the selection of material & the values for independent 

geometrical parameters with the explicit objective of either minimizing most 

significant undesirable effects or maximizing most significant functional 

requirement while making certain that the mechanical element satisfies function 

requirement & other undesirable effects are kept within tolerable limits. For 

example, if one wants to design a shaft for a machine with "Minimum weight 

criteria for that particular application" then there will be a single solution out of 

various options available. Such design is called optimum design. Optimum design is 

inclusive of adequate design. 
 

2. The objectives of optimum design 
 

For a design problem a large number of solutions are available which basically fulfill 

the functional requirement. Optimum design helps to choose the best alternative of the 

all available keeping a certain target in mind like minimizing weight or maximum 

strength or minimum cost. Following are the main objectives 
 

1)  To select the best possible option from the available alternatives keeping the target 

of maximizing a desirable effect or minimizing the undesirable effect



2)  To reach the best solution without doing the repetitive work of detail analysis and 

evaluation of each alternative (If the optimum design methods would not be there, 

we would have to design complete component considering each alternative 

material and then after lot of laborious work we would reach a conclusion) 

 

3. Johnsons Method of Optimum Design 
 

Johnson's method involves developing three major design equations and solving these 

equations. These three equations are 
 

1)  Primary design equation (PDE): It is most important equation which outlines 

the most significant functional requirement to be maximized or the most 

significant undesirable effect which is to be minimized. For example, in design of 

a tensile bar the primary target of minimum weight, then the equation for weight 

is the PDE. 

2)  Secondary design equation (SDE): The secondary or subsidiary design equation 

are the important equation other than the primary design equation. For example, 

in case of tensile bar design the equation of tensile stress is the SDE. 

 

3)  Limit Equation (LE): The limit equations are the important design equation that 

define the satisfactory ranges of certain design parameters. Like the limiting value 

of stress, or torsional stiffness etc. 

 

4.   Step by step procedure of Johnson’s method of optimum design 

 

 Following steps are followed in optimum design using Johnsons Method for normal 

specifications 

1)   Select independent geometrical parameters 

2)   Decide the basis of optimum design (like weight, cost, strength etc) 

3)   Write P.D.E 

4)   Write S.D.E and L.E 

5)   Classify parameters 

6)   Combine S.D.E 's with P.D. E‟s 

7)   Find variation of optimum design quantity 

8)   Impose L.E. on P.D.E 

9)   Write final P.D.E in terms of parameter groups 

10)   Select optimum material from comparison table for various material. 

11) Determine optimum values of geometrical parameters



5. The various design parameters and Explain Functional requirement 

parameters, Material parameters and Geometric parameters. 

The design parameter that make the design complete and successful are 

classified into three groups 
 

1)  Functional requirement parameters: These are the conditions imposed by 

the end applications on the component. These are the requirements which are 

must for the proper functioning of the component. Generally functional 

requirement parameters are independent of the material or geometric 

parameters 

 

2)  Material Parameters:   The material parameters are those parameters 

which describe the material with values like density, modulus of elasticity, 

modulus of rigidity, yield strength, ultimate tensile strength, cost per kg etc 

 

3)  Geometrical parameters: These are the parameters which define/limit the 

geometry of the mechanical component like module of gear, length of belt, 

face width of gears etc. 

6.   Desirable and undesirable effects in optimum design 
 

The functional requirements are the conditions which must be satisfied by the 

mechanical element so that it works as intended. The functional requirements are 

classified as Desirable and Undesirable effects. 
 

Desirable effects: Desirable effects are the functional requirement parameters that 

are useful for the mechanical element to perform satisfactorily its function, like 

tensile strength, power transmitting capacity, storage capacity, bending resistance 

etc. Desirable effects are best when they are maximum in value. 
 

Undesirable effects: Undesirable effects are also functional requirements but 

which are detrimental for its functioning, and are best when they have minimum 

in value. Like weight of component, cost of component, Imbalance in component 

etc. 
 

7.   Application of Johnson method: 

1)  Designing aircraft parts for minimum weight 

2)  Designing optimum production schedules 

3)  Minimum cost design of various devices 

4)  Inventory control planning 

5)  Optimum design of structural members 

6)  Optimum design of control systems and electrical circuits



7)  Finding Optimal nose cone angle for minimum drag 

8)  Designing material handling equipment‟s such as conveyers, cranes, trucks etc. for 

material handling 
 

Case Study: 
 

In light weight Equipment, a shaft is transmitting a torque of 900 Nm. and is to have a 

rigidity of 90Nm/degree. Assume a factor of safety of 1.5 based on yield stress. 

Design the shaft with minimum weight. What will be the change in design for minimum 

cost? Assume maximum shear stress theory of failure. Use the following data for the 

materials: 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 



Questions:  

1. Classify the optimization problem in detail?  

2. Differentiate between adequate and optimum design. Also explain different types of equations that 

are used in „Johnson‟s method of optimum design‟.  

3. What do you mean by primary and subsidiary design equation?  

4. Draw the step by step flow chart for Optimum Design Procedure?  

5. Explain the following with reference to optimization: i) Objective function ii) Constraints  
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